Chicago Stylesheet

- Alfred C. O’Connell Library -

This handout covers Chicago style basics, formatting, and many examples for sources noted throughout your paper and in the Bibliography list at the end of your paper.

Always consult your professor to learn his/her requirements for citation and formatting.

Chicago Style 101

1. Cover page? Yes!
2. Margins = 1 inch
3. Spacing = Double

Citing sources:

- Bibliography (list of all sources used in your paper)
- Footnotes (most common)
- Endnotes (less common)

Guide Contents:

<table>
<thead>
<tr>
<th>Bibliography &amp; Footnote examples</th>
<th>p. 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td></td>
</tr>
<tr>
<td>- Part of a Book</td>
<td>p. 6</td>
</tr>
<tr>
<td>Articles</td>
<td>p. 8</td>
</tr>
<tr>
<td>- Magazines</td>
<td>p. 9</td>
</tr>
<tr>
<td>- Journals</td>
<td>p. 10</td>
</tr>
<tr>
<td>Websites</td>
<td>p. 12</td>
</tr>
<tr>
<td>Multimedia</td>
<td>p. 13</td>
</tr>
<tr>
<td>Other Sources</td>
<td>p. 14</td>
</tr>
<tr>
<td>- Primary Sources</td>
<td>p. 16</td>
</tr>
<tr>
<td>General Rules</td>
<td>p. 17 – 19</td>
</tr>
<tr>
<td>Sample Paper pages</td>
<td>p. 20 – 21</td>
</tr>
</tbody>
</table>

Books

1. One Author
2. Two or Three Authors
3. More than Three Authors
4. Author or Editor Unknown
5. Sacred Books
6. Edited or Translated Book
7. Encyclopedias & Dictionaries
8. Repeated Author
9. Chapter or Part of a Book
10. Multivolume Books
11. eBooks (Countrywatch, SUNY Press, EBSCOHost, Google Books, Kindle, etc.)

– Genesee Community College –
1. One Author

The basic format for a book Bibliography entry is:

Author Last Name, Author First Name. Title of Book. Place of Publication: Name of Publisher, Year of Publication.

• BIBLIOGRAPHY:


The basic format for a book Full footnote/endnote entry is:

1. Author Name, Title of Book (Place of Publication: Name of Publisher, Year of Publication), specific page number being cited.

• FULL NOTE:


The basic format for a book Short footnote/endnote entry is:

1. Author Last Name, Shortened Book Title, page number.

• SHORT NOTE:

- Short notes are used for multiple citations from the same source. After a source has been fully cited the first time, a short note (or Ibid., when appropriate) should be used for each future citation from that source.

- Ibid. - The second time you cite from a source you may use either a short note OR "Ibid." but you can use "Ibid." ONLY when your note comes from the same source as the item just before it in the note list. If you are citing from the same page as the previous note then all you need is "Ibid." If it’s from a different page include the page number(s) after the “Ibid.” See the example below and/or the sample paper page starting on p. 20 for clarification.


4. Ibid., 27. #4 is also from the Bragdon book, but it is a citation from p. 27 in the Bragdon book and therefore includes the different page number.

5. Off, Bitter Chocolate, 73.
2. Two or Three Authors

- BIBLIOGRAPHY:


- FULL NOTE:


- SHORT NOTE:

  3. Cook and Herzman, Medieval World, 42.


3. More than Three Authors

- BIBLIOGRAPHY:

  For works with four to ten authors or editors, list all names in the bibliography entry.


- FULL NOTE:

  Use only the name of the first author or editor in the note, followed by “et al.” with no comma placed between the author or editor’s name and “et al.”


- SHORT NOTE:

  2. Dick et al., Emergence, 67.
4. Author or Editor Unknown

- **BIBLIOGRAPHY:**
  Use the title or a descriptive phrase in place of an author or editor’s name if there is no name available. Do **not** use articles (a, an, the) when alphabetizing these entries in the bibliography.

  *A True and Sincere Declaration of the Purpose and Ends of the Plantation Begun in Virginia, of the Degrees Which it Hath Received, and Means by Which it Hath Been Advanced.* London, 1610.

- **FULL NOTE:**
  Use the title or a descriptive phrase in place of an author or editor’s name if there is no name available.

  1. *A True and Sincere Declaration of the Purpose and Ends of the Plantation Begun in Virginia, of the Degrees Which it Hath Received, and Means by Which it Hath Been Advanced* (London, 1610), 17.

- **SHORT NOTE:**
  For books published before 1900 it is acceptable to only list the Place, Date of Publication.

  2. True and Sincere, 12.

5. Sacred Books

Religious works such as the Bible and the Qur’an are **not included in the Bibliography**, and they are cited by book, chapter, and verse, or in an equivalent manner.

- **FULL NOTE:**


6. Edited or Translated Book

- **BIBLIOGRAPHY:**
  Editor is abbreviated ed. (or eds. for more than one), and translator is abbreviated trans., and they are preceded by a comma when **there is no author**. The author’s name comes before the translator’s name, when you have one. When edited by/translated by comes after the title, it is spelled out fully.


• **FULL NOTE:**
Editor is abbreviated ed. (or eds. for more than one) and is preceded by a comma. The author’s name comes before the translator’s name (when you have one), and the word “translator” is abbreviated. When editors are listed after the title they are abbreviated as ed. (no “s”) (see footnote #2 on p.7).


• **SHORT NOTE:**
In short notes the abbreviations are not included.


**7. Encyclopedias & Dictionaries**
Encyclopedias and dictionaries are generally cited in notes but not in the bibliography. Make sure that your instructor allows you to cite from this kind of source before including it in your paper. Include “s.v.” which stands for sub verbo (Latin for “under the word”), this lets the reader know what entry you used. Use this format for shorter entries from reference books.

• **FULL NOTE:**


**Note:** #3 & #4 are from online encyclopedias.

**8. Repeated Author**
This format should only be used in the bibliography after the first entry for multiple materials by the same author. The same-author entries must appear one right after another.

The long line that replaces the author or editor’s name is called a **3 Em Dash** (———). In order for the Em Dashes to appear properly in your citations, use Microsoft Word to go to the Insert menu, click on Symbol (on the far right), click on More Symbols, then click on the Special Characters tab, select Em Dash, then click Insert 3 times.

Arrange all Em Dash entries for one author in alphabetical order by book/article title.
• BIBLIOGRAPHY:

First entry for an item by Kathleen J. Bragdon:


Second entry for an item by Kathleen J. Bragdon:


9. Chapter or Part of a Book

• BIBLIOGRAPHY:
  *A work may be an essay, short story, poem, article or chapter that appears within a book that has an editor. When using a multivolume work, list the volume number before the page number or numbers (for example, volume two, pages 33 through 55 would appear as 2:33-55).

Note that the editor information is not abbreviated in the bibliography entry.


• FULL NOTE:
  When using a multivolume work, list the volume number before the page number(s) (for example, volume two, page 35 would appear as 2:35). Use this format for longer entries with authors from reference books.


10. Multivolume Books

• BIBLIOGRAPHY:


• FULL NOTE:


• SHORT NOTE:

11. eBooks
(Countrywatch, SUNY Press EBook Collection, EBSCOhost eBook Collection, Google Books, and books from eReader devices – Kindle, nook, iPad/Pod, etc.)

• BIBLIOGRAPHY:


• FULL NOTE:


4. Frederick Douglass, *Narrative of the Life of Frederick Douglass* (Lexington, KY: SoHo Books, 2010), Kindle edition, part III.

Note: Indicate which format/device you used and a specific chapter or section rather than page numbers.
Newspaper, Magazine, and Journal Articles

Note 1: Do not include database information when citing an article you found in print. Stop your print article citation after the date (if newspaper) or page number(s).

Note 2: Do not include a database web address/URL when citing an article you found in print. Stop your print article citation after the date (if newspaper) or page number(s).

Note 3: See previous section above for how to cite from online books.

1. Newspaper
2. Magazine
3. Online Magazine
4. Journal
5. Online Journal

1. Newspaper Article

The basic format for a newspaper article Bibliography entry is:

Author Last Name, Author First Name. “Title of Article.” Title of Source, Month Day, Year of Publication, edition/section. DOI OR stable web address/URL OR Name of Database (Document or Accession Number/ID).

• BIBLIOGRAPHY:
*N ewspaper articles are not usually included in a bibliography. However, some instructors require them. Always follow the directions given by your instructor.


• FULL FOOTNOTE/ENDNOTE:
Do not include “The” as part of newspaper titles.

The basic format for a newspaper article Full Footnote/Endnote entry is:

1. Author Last Name, Author First Name. “Title of Article.” Title of Source, Month Day, Year of Publication, edition/section. DOI OR stable web address/URL OR Name of Database (Document or Accession Number/ID).

• FULL NOTE:
Do not include page numbers for newspaper articles. Include newspaper edition, if available.


The basic format for a newspaper article **Short endnote/footnote** entry is:

1. Author Last Name, “Shortened Article Title.”

**SHORT NOTE:**

- Short notes are used for multiple references from the same source. **After a source has been fully cited the first time**, a short note should be used for each future reference to that source.
- **Ibid.** - The second time you cite from a source you may use either a short note OR “Ibid.” but you can use “Ibid.” **ONLY** when your note refers to the item just before it in the note list. If you are citing from the same page as the previous note then all you need is “Ibid.” If it’s from a different page include the page number(s) after the “Ibid.” See the sample paper page on p. 18 for clarification.
- Titles shorter than **four** words are not shortened. Do not include initial articles – *The Old Man and the Sea* would become *Old Man*.


### 2. Magazine Article

The basic format for a magazine article **Bibliography** entry is:

Author Last Name, Author First Name. “Title of Article.” *Title of Source*, Month Day, Year of Publication. DOI OR stable web address/URL OR Name of Database (Document or Accession Number/ID).

**BIBLIOGRAPHY:**


The basic format for a magazine article **Full Footnote/endnote** entry is:

1. Author Name, “Title of Article,” *Title of Source*, Month Day, Year of Publication, specific page number being cited (if available), DOI OR stable web address/URL OR Name of Database (Document or Accession Number/ID).

**FULL NOTE:**


The basic format for a magazine article **Short endnote/footnote** entry is:

1. Author Last Name, "Shortened Article Title," page number.

**SHORT NOTE:**


3. **Online Magazine**

   **BIBLIOGRAPHY:**


   **FULL NOTE:**


4. **Journal Article**

   The basic format for a journal article **Bibliography** entry is:

   Author Last Name, Author First Name. "Title of Article." *Title of Source* Volume number, no. issue number (Year of Publication): First page number-Last page number. DOI OR stable web address/URL OR Name of Database (Document or Accession Number/ID).

   - Do not include “The” as part of journal titles.
   - Only the year is required for journal articles.

   **BIBLIOGRAPHY:**


5. **Online Journal**

5. **BIBLIOGRAPHY:**


Websites and Multimedia

Citations for websites are usually dealt with as notes and not as entries in the bibliography; however, your instructor may require you to list websites in your bibliography. Always check with your instructor and follow their assignment guidelines carefully.

*Note: Websites are not usually included in a bibliography. However, some instructors require them. Always follow the directions given by your instructor. Personal communications and legal works are NOT included in the bibliography.

See Books – 10. eBooks (p. 6) for how to cite from online books from places such as Google Books, Countrywatch, etc.

1. Basic Website
2. Online Multimedia
3. Photographs
4. DVDs and Videocassettes

1. Basic Website

The basic format for a website Bibliography entry is:

Author Last Name, Author First Name. "Title of Article or Page within a Website." Sponsor/Owner of Website or Database. Publication Date/Date of Last Revision/Modification OR an Access Date. Web address/URL.

• BIBLIOGRAPHY:

Websites are not usually included in a bibliography. Always follow the directions given by your instructor and include websites in your bibliography if they want you to.


The basic format for a website Full Footnote/endnote entry is:

1. Author Name, "Title of Article or Page within a Website," Sponsor/Owner of Website or Database, Publication Date/Date of Last Revision/Modification OR an Access Date, web address/URL.

• FULL NOTE:

When a site has no author, start with the title.


The basic format for a website **Short endnote/footnote** entry is:

1. Author Last Name, “Shortened Website Title.”

**SHORT NOTE:**

3. “Was the Story.”


**2. Online Multimedia**

Online multimedia includes such items as MP3s, MPEGs, JPGs, etc. Always include the type of media used, the access date (if your instructor requires it) and the web address/URL (if applicable).

**BIBLIOGRAPHY:**


**FULL NOTE:**


**3. Photographs**  
*Use this format for photos you have personally taken.*

**BIBLIOGRAPHY:**


**FULL NOTE:**

4. DVDs and Videocassettes

- **BIBLIOGRAPHY:**


- **FULL NOTE:**


Other Sources

1. National Archives - Civil War Service Records
2. Interviews - Published
3. Interviews - Unpublished
4. Lectures/Course Materials
5. Personal Communications
6. Legal Citation - Laws and Statutes
7. Legal Citation - United States Supreme Court Decisions
8. Primary Sources
9. Secondary Sources

1. National Archives - Civil War Service Records

- **BIBLIOGRAPHY:**


- **FULL NOTE:**


2. Interviews - Published

Interviews must include the name of the person who was interviewed, name of the interviewer, brief identifying information and place, and/or date of the interview.

- **BIBLIOGRAPHY:**

• FULL NOTE:


3. Interviews - Unpublished
Only published interviews are included in a bibliography.

• FULL NOTE:


2. John Joseph (WWII Veteran), interview by Gail Smith, Genesee Community College, April 4, 2011.

4. Lectures/Course Materials
The speaker/author, title, material type, location, and date of the speech/material should all be provided.

• BIBLIOGRAPHY:

Swanson, Garth. “Rosie the Riveter: Women in the Workforce, WWII and Beyond.” Power Point presentation for HIS 102 online, Genesee Community College, Summer 2017.


• FULL NOTE:


2. Garth Swanson, “Rosie the Riveter: Women in the Workforce, WWII and Beyond” (Power Point presentation for HIS 102 online, Genesee Community College, Summer 2017).

5. Personal Communications

• FULL NOTE:

1. Howard Zinn, e-mail message to author, June 1, 2005.

6. Legal Citation - Laws and Statutes

• FULL NOTE:


2. N.Y. Const. art. XI § 2. Article and amendment numbers use Roman numerals (I, II, III) and section and clause numbers use Arabic numerals (1, 2, 3).
7. Legal Citation - United States Supreme Court Decisions
Do not use versus or vs. for U.S. Supreme Court citations; only v. is acceptable.

• BIBLIOGRAPHY/FULL NOTE:

8. Primary Sources

• BIBLIOGRAPHY:

• FULL NOTE:

9. Secondary Sources
Citations from secondary sources (“quoted in...”) are discouraged; authors are expected to review each item cited. If the original source is not available, both the original and secondary sources must be listed in the citation.

• FULL NOTE:
General Rules

Authors
- Always include full names whenever you can. See basic format boxes for formatting guidelines.

Bibliography
- **One to ten authors/editors are all listed.**
- Only the **first author’s name is reversed**, commas follow the names of **all** authors, and the word “and” **always** precedes the last author (Smith, John, Jane Doe, and John Q. Public.)
- For **more than ten authors**, list only the **first seven** authors followed by “et al.”

Footnotes/Endnotes
- For an item with **more than three** authors or editors only the name of the first author/editor is included followed by the words “et al.” with no comma between them (see 3. More than Three Authors on p. 3).

Titles
- Capitalize all important words – first word of the title, first word of the subtitle (right after the colon) and all other major words. Do not capitalize words such as: a, an, the, against, between, in, of, to, and, but, for, and so, unless they are the first word of the title or the subtitle.
- Put the following titles in *italics* – *books, periodicals, plays, movies, TV & radio programs, operas, album titles, paintings, statues, and cartoons.*
- Put the following titles in “quotation marks” – “periodical articles,” “book chapters,” “short stories,” “poems,” “specific songs,” and “photographs.”
- Titles of books are taken from the title page (first printed page of the book) and not from the cover. If the title on the title page starts with any of the initial articles “A,” “An,” or “The” include it in your citation, but be sure to alphabetize by the second word.
- When titles or subtitles end with question marks or exclamation points they are **not** followed by a colon or period (see Magazine example on p. 8 and note #3 of the Journal article examples on pp. 10-11). However, if a comma should come next, be sure to include it (see example Full Note #1 of Basic Website on p. 12).

Page numbers

Newspapers
- **Bibliography & Footnotes/Endnotes**: Do not include page numbers, instead end with edition (late edition) or section number/name. (sec. 1/sec. A/Sports section).

Magazines
- **Bibliography**: Do not include page numbers.
- **Footnotes/Endnotes**: Include specific page number(s). For items without page numbers you may include either a paragraph number (para.) or a section heading (sec.) to indicate the specific section, but this is **not** required.

Journals
- **Bibliography**: Include page range (250 – 265).
- **Footnotes/Endnotes**: Include specific page number(s). For items without page numbers you may include either a paragraph number (para.) or a section heading (sec.) to indicate the specific section, but this is **not** required.
Dates
- Do not put magazine and newspaper article dates in parentheses. For newspaper and magazines articles use Month Day, Year format - July 25, 2016.
- For books and journal articles just use the year.

Publishers
- Shorten publishers names by removing such words as The, Inc., Co., & Co., and Publishing Co.
- Do not include state of publisher if it is a part of the publisher’s name.
- Include states only for lesser known cities, but always include D.C. with Washington.

Abbreviations

Bibliography
- “Edited by” and “Translated by” are spelled out fully.

Footnotes/Endnotes
- “Edited by” and “Translated by” are abbreviated as (ed.) and (trans.).

Formatting in the Body of the Paper

There are two notation styles in Chicago: endnotes and footnotes. Pick ONE style and use it throughout the entire paper.

- Note numbers in text are formatted as superscript, which is half a space above the line. To get a superscript number in Microsoft Word 2016 or 2010, place your cursor where you want to insert a note, click on the References tab and then click on either Insert Footnote or Insert Endnote. Neither version of Word will create Notes/Bibliography entries in the current version of Chicago (16th ed.). If you use this feature double check against this stylesheet.

Footnotes/Endnotes
- Endnotes appear on a separate page (or pages) at the end of the body of the paper but before the bibliography. The heading for the endnotes page(s) should consist only of the word Notes. Footnotes appear at the bottom of each page.
- The first line of the note must be indented half an inch. Only the first line should be indented, not the entire note. Single-space each note and double-space between notes, unless your instructor has given you other directions. Microsoft Word does not do either of these things automatically when creating notes.
- The font size of notes should be 2 sizes smaller than the font size used in the main body of the paper. A paper with a text font size of 12 point should have notes with a font size of 10 point. In order for notes to be readable, do not make the font size smaller than 9 point.

Bibliography
- The entries in a Bibliography are listed alphabetically by authors’ last names (or by title when no author is given).
Long Quotations

- If a quotation continues for six to eight lines or 100 words, it should be set as a block quotation. Block quotations should begin with a lowercase letter unless there is no material that precedes it. Do not double-space the quotation. End the last sentence of the block quotation with a period followed by your footnote or endnote number.

For example:

Rose informs us that

the tension between applied science and pure research has been a long-standing one in American history. The goal of applied research is the discovery of useful knowledge – a cure for cancer, for example. The goal of pure research is knowledge for its own sake, without practical application. Throughout American history the proponents of applied science have held the upper hand. In the eighteenth century the prestige of Thomas Jefferson and Benjamin Franklin, the nation’s most prominent scientists, set the scientific agenda.¹
The first line of the note must be indented half an inch. Only the first line should be indented, not the entire note. Single-space each note with double-spacing between notes, unless your instructor has given you other directions. Microsoft Word does not do either of these things automatically when creating notes.

Your professor may prefer specific variations to the way your foot/endnotes and bibliography citations look, which may differ from the way they are presented in this guide.

Always consult your professor to learn if he/she has any special requirements for citations.

Follow your instructor’s directions for what information they want on your title page.

Use the References tab to insert your footnotes. Be sure to indent the first line and double-space between each footnote – Word will not do this for you automatically.

Note that footnote entries have commas separating each part (Author, Title, etc.).

Dinter was my 1st footnote, but I have cited from Krcmarik since then, so I have to use a short note for him for my 4th footnote.

Because my 2nd footnote comes from the same source (but a different page) as my 1st, I can use “Ibid.” and the page number.

Note that footnote entries have commas separating each part (Author, Title, etc.).

Dinter was my 1st footnote, but I have cited from Krcmarik since then, so I have to use a short note for him for my 4th footnote.

Because my 2nd footnote comes from the same source (but a different page) as my 1st, I can use “Ibid.” and the page number.


2 Ibid., 34.


4 Dinter, *World of Tattoo*, 49.
Sample Bibliography

The **Bibliography** list includes all the sources used in the research and writing of your paper and it should be on a separate page at the end of the paper, **single-spaced with double-spacing between entries**, and in **alphabetical order** by the authors' last names (or by title when no author is given, ignoring “A,” “An,” and “The”).

Your professor may prefer specific variations to the way your foot/endnotes and bibliography citations look, which may differ from the way they are presented in this guide.

**Always** consult your professor to learn if he/she has any special requirements for citations.

<table>
<thead>
<tr>
<th>Bibliography entries have <strong>periods</strong> separating each part (Author, Title, etc.)</th>
</tr>
</thead>
</table>

**Bibliography**


---

**For More Information**

For more information, the *Chicago Manual of Style* (16th ed., 2010, **REF LB2369 .C53 2010**), is available at the Alfred C. O’Connell Library.

Current information on citing electronic and web resources is found at the Chicago Manual of Style website at: [http://www.chicagomanualofstyle.org/tools_citationguide.html](http://www.chicagomanualofstyle.org/tools_citationguide.html).

For help in deciding the difference between responsible writing and plagiarism, see the following websites: [http://owl.english.purdue.edu/owl/resource/589/01/](http://owl.english.purdue.edu/owl/resource/589/01/) or [https://wts.indiana.edu/writing-guides/plagiarism.html](https://wts.indiana.edu/writing-guides/plagiarism.html).

**Questions? Ask a Librarian:**

<table>
<thead>
<tr>
<th>In Person</th>
<th>Library Information Desk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>585-343-0055 Ext. 6419</td>
</tr>
<tr>
<td>Email</td>
<td>Click Email from the library’s web page</td>
</tr>
<tr>
<td>Chat</td>
<td>Click Chat online from the library’s web page</td>
</tr>
</tbody>
</table>